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[wvanor co3paHmna HOBOroO NPoeKTa.

YKasaHuWe KaTasiora npoeKTa, a TakKe ero MMeHun u umeHu top-level moayns. Top-level mogyns - 3To, cBOEro poaa, TOYKa BX0Aa,
MOAY/1b, KOTOPbIN By AET 3anNyCKaTbCA NEPBbIA U K KOTOPOMY NOAK/OYEHbI BCE OCTa/lbHble MoAyaN. Kak GyHKUMA main B Cu.

Directory, Name, Top-Level Entity

What i= the working directory for this project?

| D-alttera_lite'15. 1\quartusibing4

What iz the name of this project?

| your_project_name

What iz the name of the top-level design entity for this project? Thizs name iz case sensitive and must exactly match the entity name in the design file.

|gse Existing Project Settings... |

MyTb K NPOEKTY NyyLle cpaly NOMe HATb Ha bonee yao6HbIi. Cpesia He CO3AaET NaNKM C UMEHEM NPOEKTA, TaK YTO €€ HYKHO
nponucatb B NyTH camomy. T.e Bmecto “D:\altera\projects” caenatb “D:\altera\projects\NameOfMyFirstProject”. (nam Kak Bbl
Tam Ha30BE&Te CBOW NepBblii NPOEKT)

Directory, Name, Top-Level Entity

What is the working directory for this project?

| D:Aalteral15. 1'guartus\preject

What is the name of this project?

|ynur_pru}ec1_name

What is the name of the top-level design entity for thizs project? This name iz case sensitive and must exacthy match the entity name in the design file.

|y|:rur_prnjec1_name

Use Existing Project Seftings...




B cpefie ecTb BO3MOMKHOCTb CO34aBaTb WwabnoHHble NPOEeKTbl, HO 06 3TOM no3xe. [oKa CO34aéM I'IVCTOVI.

Project Type

Select the type of project to create.

(®) Empty project
Create new project by specifying project files and libraries, target device family and device, and EDA tool settings.
O Project template

Create a project from an existing design template. Y'ou can cheose from design templates installed with the Quartus Prime software, or download design
templates from the Design Store.

B cnepytowem ware gManora MOXHO 3apaHee f06aBUTb B NPOEKT $aii/ibl UCXOAHOIO KOAa. ITO Ham NoHaaobuTca B byaywem.
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Bbibupaem uenesyto moaens MNJINC, nogKoTopyto 6yaeM KOMNUANPOBATb.

Family & Device Settings

Select the family and device you want to target for compilation.
fou can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device iz supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list

Famiby: |Cyc|nne WV (E/GKIGTISXISEIST) e | Package: | FBGA

Devices: | Cyclone V E Base *  Pincount 484

Target device Core Speed grade: |?

Mame fitter: |

Auto device selected by the Fitter

(@) Specific device selected in "Available devices® list Show advanced devices

Other: nia

Available devices:

Hame Core Voltage ALMs Total I0s GPIOs GXB Channel PMA GXB Channel PCS PCle Hard IP Bl
SCEBAZF23ICT 1.1V 224 224 0 0 0
SCEBASF2ICT 1.4V 240 240 0 0 0
SCEBATF2ICT 1.1V 58420 240 240
SCEBASF23ICT 1.1V 113560 224 224

TYT MHOTO Pa3HbiX NApPamMeTPOB, HO CamMble MHTEPECHbIE, A1A Hac, B CTPoKe Simulation. TyT MoXKHO BbI6GpaTb UCNONb3yeMbl it
CUMYIATOP U A3bIK MO YMONYAHUIO 4/18 CUMYALMUN.

EDA Tool Settings

Specify the other EDA tools used with the Quartus Prime software to develop your project.

EDA tools:

Tool Type Tool Name Format({s) Run Tool Automatically

Design Entry/Synthesis | Precizsion Synthesis VaK - |:| Run this tocl automatically to synthesize the current design

Simulation ModelSim-Altera erilog HOL - ||:| Run gate-level simulation automaticalty after compilation

Formal Verification =Nones=

Board-Level Timing STAMP

Symbol FPGA Xchange
Signal Integrity HSPICE

Boundary Scan <None=




MepenTemKaK HaxkaTtb “Finish” MoXHO BCE NpoBepuUTb M ybeAnTbCA B MPaBUIbHOCTM 3aN0THEHUS AaHHbIX NPOEKTa.

Summary

When you click Finish, the project will be created with the following settings:

Project directory:

Project name:

Top-level design entity:

Number of files added:

Humber of user libraries added:

Device assignments:
De=ign template:
Family name:
Device:
EDA tools:
Design entry/synthesis:
Simulation:
Timing analysis:
Operating conditions:

Core voltage:

D:falteral5.1/qguartus/projects/
your_project_name
your_project_name

a

a

nia
Cyclone W (E/GH/IGTISHISEIST)

SCEBA4FZICT

Precision Synthesis (WQM)
ModelSim-Altera (Werilog HDL)

0

Junction temperature range:

BOT HalW NPOEKT M co34aH, HO OH, MOKayTo, NycTon. Y1o 66l £06aBUTL B HEro $aiil MCXO4HOro KoAa Haxumaem File->New.
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MNoaBuUTCA ANMANOr € BO3MOXKHOCTbIO Bbl6paTb T™MN co3aaBaemoro cbal‘/'ma.

MoHo co3gaTb Kak VHDL dann.

New Quartus Prime Project
4 De=ign Files
AHDL File
Block Diagram/Schematic File
EDIF File
O=ys Sy=tem File
State Machine File
SystemVeriog HOL File
Tcl Script File
Werilog HOL File
[WHDL File
4 Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File
4 Verification/Debugging Files
In-Sy=stem Sources and Probes File
Logic Analyzer Interface File
SignalTap Il Logic Anahyzer File
University Program VWF
4 Other Files
AHDL Include File
Block Symbol File
Chain Description File

oK || Cancel ||

OTKpOeTCA OKHO peAaKTUpoBaHUA Halero daina. Yto 6bl N0ABMNACE BOSMOXHOCTb €10 COXPAHUTb, HY»KHO BHECTU KaKue -
HUBYAb n3meHeHUA B Hero. MNocne yero Haxkumaem File->Save.

Tak u Verilog

New Quartus Prime Project

4 [Design Fies
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HOL File
Tcl Script File

[werilog HOL File

WHOL File

4 KMemory Files
Hexadecimal {Intel-Format) File
Memory Initialization File

4 Yerification/Debugging Files
In-System Sources and Probes File
Logic Anakyzer Interface File
SignalTap Il Logic Analyzer File
University Program WWF

4 Other Files
AHDL Include File
Block Symbol File
Chain Description File

oK || Cancel || Help

Bt Vew Proest Assonments
O A4 D0 D C poupoeciname | Y EE 2 D> ¥ S S5 VEH
Project Navigator |\ Hierarchy v |=[H]8 x your_project_name.v (<]l | cataog (W&

Entiynstance

o

i Cyclone V: SCEBA4F23CT

4 g nstalled P
@ your_project_name 1t s Project birectory
o Sekection Avaiable
b
@ seorch for Pariner P
[Tasks| Compilation v =[@s x
Task
4 ) Compile Design
> W Analysis & Synthesis
© P Fiter (Place & Route)
o Assent rogramming |
D P TimeQuest Timing Analysis
b P EDA Netist Wrter
B Eat Setings
3 Program Device (Cpen Programmer)
< 5|« > ||+ A

Type ID  Message

ges |l | @ =

P

00:00:00




B cnefytoliem OKHe MOXKHO COXPaHUTb Galin B N0BYto NanKky Ha gucke. Jlyylie COXpaHATb B NanKy NpoeKTa. Tak ke nepBomy
fobasnaemomy dainy ydwe 4atb MMA, coBnagatoliee ¢ umeHem top-level, KoTopoe 6b1/10 yKa3aHO NPU CO34aHMM NPOEKTA.
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Tenepb MOMKHO HAYMHATb pa6OTaTb. Ho, uto 6bi 6bI/10 npouwe HavyaTb, MOXXHO BOCMO/1b30BaTbCA 0AHOM ManeHbKow XUTPOCTbIO.

Ec/u HaxKaTb Ha KHOMKY, Ha KOTOPYIO Ha C/ie Ay HOLLEM PUCYHKE YKa3biBaeT 60/1bluan KpacHasA CTPesiKa, TO MOABMTCA eLE 04HO
[IMan0roBoe OKHO.
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Jroject_name S EEN D ES SAEVE

7 =

vour_project_name.v

vl = =

i ©

B T EE mpfRm 0
module your_project_name

#(parameter WIDTH=16)
=Y

input signed [WIDTH-1:
input signed [WIDTH-1:0
output [WIDTH-1:0] resul
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Language templates:

3TO OKHO ¢ WabnoHamn Koga. TyT ecTb roToBble WabnoHbl n ana Verilog v gna VHDL. CheBa oTobparkeHO AepeBo C MMeHaMM
WabnoHOB, CNpaBa cam TeKCT WwabsoHa. HaxkaTuem KHOMKM Insert MOXHO BCTaBUTb WabnoH B dain.

[ TCL
[» Weriog HOL
4 WHDL
4 Full Designs
[ RAM=s and ROMs
[+ Shift Registers
4 State Machines
Four-State Meahy State Machine
Four-State Moore State Machine
Safe State Machine
User-Encoded State Machine
[» Arithmetic
[» Configurations
[+ Constructs
[* WHDL 2008 Constructs

qQuartus Prime VHDL Tem|
Four-state Mealy State

A Mealy machine has ouw
the inputs. When the

immediately, without w
can be written more th

library ieee; _
use ieee.std_logic_1164.a

Bentity four_state_mealy_s

port
=
clk

input
reset

Language templates:

Prewview:

AHDL
Quartus Prime TCL
TimeQuest
Systemerilog
TCL
“erilog HOL
4 Full De=signz
[ RA&M= and ROMs
Shift Registers
State Machines
Arithmetic
4 Adders
Signed Adder
Un=igned Adder
Signed Adder/Subtractor (£,

>

S/ qQuartus Prime Verilog Ter
/7 signed adder

module signed_adder
#{parameter WIDTH=16)
=l

input signed [WIDTH-
input signed [WIDTH-
input cin,

output [WIDTH:O0] re:

J;
assign result = dati

endmodule




TaK ke Bam MoKeT 6bITb MHTEPECHa BOT 3Ta KHoMKa. OHa 3anycKaeT NpoBepKy CMHTaKcKca TekyLero daina.

‘ocessing Toole Window  Help "
wroject_name b ="€¢$ﬁ@h#ﬁ0 @.ﬁ.af‘
j ox @ vour_project_name.v

E 8T EErmnrmils B =

1 module your_project_name

2 #(parameter WIDTH=16)

3 80 | ,

4 input signed [WIDTH-1:0] d ,

5 input signed [WIDTH-1:0] dat L

5] output [WIDTH-1:0] result_async,

Koraa Bbl nocumTaeTe, YTo MPOEKT roTOB, €0 MOXKHO CKOMMNUAMPOBATb HaxaTnem Processing->Start Compilation.

Processing | Toole Window Help '

Bl  Stop Processing Ctrl+Shift+C L

=] *#

=[1 > start Compiation CtrlsL |
1 E Analyze Current File |!
Start r |

Update Memory Initialization File
Compilation Report Ctri+R
Dwnamic Synthesis Report

PowerPlay Power Analyzer Tool

SSN Analyzer Tool

Hw OC¢

Receive Compilation Status Notifications
ot i i 1 = B - T

T a ow o

L I

MOCKOIbKY KOMMUAALMA MOXKET MATU AO0BO/IbHO A0/110, UHOTA M0/1€3HO BOCMNO/1b30BaThCA KHOMKOM “

Analysis & Synthesis” ana

3anyCKa CUHTE3a NPOEKTa (STO camblii I'IepBblﬁ 3Tan KOMNMUNAUUKN, YTO-TO BPOAE NOCTPOEHUA BHYTPEHHErO npeacTtaB1eHNA MO

BaLLeMY UCXOAHOMY Koay).
| |
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Task
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Tak ke Bam moxkeT noTpeb0oBaTbCA NOCTaBUTL B COOTBETCTBME NOPTaM Ballero Moayns Homepa Hor MMKPOCXEMbl. ITO MOMKHO
caenatb B MmeHo Assignment->Pin Planner. Ho, uto 6b1 66110 npolue paboTaTtb, 06A3aTeNbHO CUHTE3UPYITE Nepen STUM CBOM

NPOEeKT.
Aszsignments | Processzing Tools Window  Help
t* Device...
12" Settings... Cirl+Shift+E
1 é Assignment Editor Cirl=Shift+A
@ Pin Planner CtrlShift+N
Remove Assignments... ;
r’.‘. Back-&nnotate Assignments... d
Import Assignments... |
Export Az=signments... |t
Agzsignment Groups. .. :
=] LogicLock Regions Window Alt+L
Design Partitions Window Alt+D
1 1 T TS

OTKpOeTCA HOBOE OKHO. B HUMHe I ero 4acTi MMeeTcA NO/HbIN CMIMCOK Bcex NopToB top-level moaynsa Hawero npoekTa. Kaxaan
CTPOKa COOTBETCTBYET 04HOMY 6UTY. A TOro, 4Tobbl NPUBA3aTb KAKOM-TO MOPT K HOrEe MUKPOCXEMY, HY}KHO BOWUTb B KOJIOHKY
Location B CTpOKe COOTBETCTBYIOLLEro NopTa HOMEP HOMM MUKPOCXeMbl. Ha KoNoHKy Location Ha KapTuHKe yKa3biBaeT KpacHas

cTpenka. Homepa HOr MOXHO MNOCMOTPETb B AOKYMeHTauuu K nnaTe « DEQ-CV».

M mman crpenys Ha KapTUHKeE YKasbiBaeT Ha M306parkeHUe caMo MUKPOCXEMbI, BAPYT BaM byAeT MHTepecHo. ae MMeHHO Ha
yune PacrnosioXKeHa CoOTBETCTBYHOLLAN HOra.

CuHAA CTpeKa YKa3blBaeT Ha NaHe b C PaclUMPPOBKOM 3HAUKOB, KOTOPbIMM 0603HAYAKOTCA HOTM MUKPOCXEMbI. TYT MOXHO
MOHATb KaKan M3 HOT OTBEYAET 3a TAaKTOBbIM CUTHA, KaKas 3a JIOrMYeCKUA BBOA/BbIBOA MU T.4,
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[iStesrps i) a VREF
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) Node ame Direction Location REF Group VO Standard Reserved Current Sirength Slew Rate Ditferential Pair  ser Analog Seftings GXB/VCCT_GXB\ ceiver U0 Pin Termi Jedicated Refck Pi Common Mode Dri smiter Slew Rate C =r Differential Outpy 3uffer Common Moc A
el & clock Input | | 25V (defaut) T2mA (default)
& data_a[0] Input | | 25V (defaut) T2mA (defautt)
& data_al1] Input | | 2.5V (defaull) 12mA (default)
& data_al2] Input | | 2.5V (defaull) 12mA (default)
& data_a[3] Input | | o 2.5V (defaull) 12mA (default)
o data_al4] Input H 25V (defaul) 12mA (defaul)
o data_a[5) Input 5 25V (defaul) 12mA (defaul)
i data_al6] Input H 4 25V (defaul) 12mA (defaul)
& data_a[7] Input S 25V (defaul) 12mA (defaul)
& data_a[g] Input [ | 25V (defaul) 12mA (defaul)
i data_a[9) Input H 0. 2.5V (defautl) 12mA (defaul)
& data_ali0] Input i 25V (defaut) 12mA (defaul)
& data_al11] Input i 25V (defaut) 12mA (defaul)
& data_a[12] Input | 2.5V (defaull) 12mA (default)
& data_a[13] Input | | Y 2.5V (defaull) 12mA (default)
& data_a[14] Input | N 2.5V (defaull) 12mA (default)
o |- data_a[ls] Input I | 25V (defaul) 12mA (defaul)
£ | data bim Inout o 7SV (defal) A7mA (defauk) M
=< >
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Mocne Toro, Kak BCE TOYHO FOTOBO MOYKHO HaKaTb KHOMKY Program Device, YTo6bl OTKPbITb NPOrpammy, 3a/1MBatoLLLYO
MPOLUMBKY B MMKPOCXEMY.

[ < ol

Tasks Compilation v |=[g® x

Task
4 P Compie Design
[= = Analysis & Synthesis
[ [ Fitter (Place & Route)
P Assembler (Generate programming
P TimeQuest Timing Analysis
EDA Netlist Writer
it Settings
F& Program Device (Open F‘rugrammer}|

A AR YA

OTKpoeTcA cneayoLLee OKHO.

CuHAA cTpenka — B camom Havane HYXKHO HaXaTb cloAa, YTobbl BbIGpaTh nporpammarop. flonkeH 6biTb noaknioveH K MK.
3enéHan cTpenKa — HAXKATUEM Ha ITY KHONKY MOXHO 3acTaBuUTk Nporpammarop uckate N/IUC, noaknoueHnHyo Kk MNK.
KpacHaa ctpenka — Bawa MN/IUC, echu oHa nogKNO4EeHA K KOMNbIOTEPY U HallaeHa Nporpammoid.

MEnTan CTPenna - TYT MOXMHO OyAeT BOpaTe @aln, 3arpymaemel Ha MNAKUC

®duonetToBan CTpenKa— HaAXMUTE CloAa, N GITY 3anycTutb Npouecc NPoLwnBKH.

YépHana cTpenka — nporpecc 3arpy3ku npoLlumnBKu. XenarenbHO HUYEro He TPOraTb, MOKa He 3aBePLUMNTCA.

Edit View Processing @ \indow Hep @ | search attera.com

Hardware Setup™. | No Hardware Mode: |.ITAG Progress: ’

-
-

|:| Enable real-time ISP to allow background programming when available

m Checksum Usercode Program/ Werify Examine
w1 Start Configure

01399609

e change File...
ﬂl Save File
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